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Cities around the world are embracing green infrastructure. Besides reducing the quantity of 

stormwater runoff and improving water quality, green infrastructure can help communities 

reduce heat island effects, protect wildlife habitat and improve air quality. The definition of 

green infrastructure used in this lesson relates to urban stormwater management, specifically 

how nature-based solutions can help mitigate flooding. As defined by the U.S. Environmental 

Protection Agency in 2019, green infrastructure is "...the range of measures that use plant or soil 

systems, permeable pavement or other permeable surfaces or substrates, stormwater harvest and 

reuse, or landscaping to store, infiltrate, or evapotranspirate stormwater and reduce flows to 

sewer systems or to surface waters.” 

 

Before the addition of green infrastructure in an urban setting, just about all the rainfall that falls 

onto an impervious surface, such as a parking lot, becomes direct runoff into storm sewers. After 

the addition of green infrastructure, stormwater runs off surfaces into features such as bioswales, 

engineered wetlands, or through porous pavement, allowing the water to be slowed, infiltrated, 

and managed closer to where it falls. 

 

As an emerging strategy to mitigate flooding, it can be difficult to quantify and visualize the 

cumulative impact that green infrastructure has on a community. Using one of Esri's products, 

ArcGIS GeoPlanner (https://doc.arcgis.com/en/geoplanner/), the University of Wisconsin Sea 

Grant Institute developed a template that helps assess the impact of placing green infrastructure 

features on an urban landscape. This template allows its users to place different types of green 

infrastructure in an area and visualize the full impact that these practices have on reducing 

runoff. It uses local geospatial data as a guide and allows the comparison of alternative scenarios. 

The template can be implemented at a variety of geographic scales, ranging from a development 

site to a neighborhood, to an urban drainage catchment, to a municipality and ultimately to an 

entire watershed. As such, it is a powerful tool to help communities locate and assess green 

infrastructure practices to store, absorb and filter stormwater runoff. 

https://doc.arcgis.com/en/geoplanner/
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Requirements: 

• Publisher or Administrator role in an ArcGIS organization (You can get an ArcGIS free 

trial subscription at https://www.arcgis.com/features/free-trial.html) 

• ArcGIS GeoPlanner 

 

Lesson Plan 

• Choose the template and set up the project (10 minutes) 

• Gather and add the data (10 minutes) 

• Set the study areas (10 minutes) 

• Create the design layers (20 minutes) 

• Create the dashboards to measure impact (20 minutes) 

• Design green infrastructure scenarios (30 minutes) 

 

 

Choose the template and set up the project 

 

There exists a variety of GeoPlanner for ArcGIS templates curated by Esri and others. They 

range from Military Mobility to Special Event Planning. The template you will create from 

scratch in this lesson will feature the ability to locate and assess the cumulative impacts of green 

infrastructure practices to capture/infiltrate urban stormwater runoff. Esri already has a curated 

Green Infrastructure Planning template, however the definition of green infrastructure and broad 

scale of application differ from the local stormwater management focus of this lesson. 

 

1. Sign into your GeoPlanner for ArcGIS account: https://geoplanner.arcgis.com/. 

2. Click the Create New button in the upper right corner. 

 

  
 

Make sure the Curated tab is selected. You have the option to explore a variety of Esri-

curated templates that include Land Use Planning, Public Safety and others. 

3. Search for or scroll to find the GeoPlanner Basic Template 

4. Click the Preview button to view the symbol palette that you will be working with and 

editing. Click Cancel to leave the preview window. 

  

https://www.arcgis.com/features/free-trial.html
https://geoplanner.arcgis.com/
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5. Click Select in that same pop-up window 

 

 
  

6. In the Title box, type: “Green Infrastructure for Urban Stormwater.” 

7. In the Summary box, type: “The Green Infrastructure for Urban Stormwater project 

helps you locate green infrastructure practices and assess different scenarios to reduce 

stormwater runoff to meet community goals.” 

8. In the Description box, type: “This project includes symbols, dashboards and geospatial 

data layers to help you locate green infrastructure practices and assess scenarios to 

reduce urban stormwater runoff to meet community goals. It includes one point and 

three polygon design feature layers that represent different green infrastructure 

practices. It also contains geospatial data layers to help you map effective locations to 

site practices. You can customize the symbols and attribute default values using the 

Design Types editor.” 

9. Tags: green infrastructure, stormwater management, urban runoff, flooding 

10. Click the Create button  

 

  
 

a. The next display will bring you to a world map. This may take a couple minutes.  
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11. Click the search magnifying glass,  

 

 
   

search for “Green Bay, Wisconsin.” Among the choices, select “Green Bay, WI, USA 

(Brown County)” to zoom to that location. 

12. Click the Extent button  

 

 
 

select + Add Bookmark, label it “Green Bay, Wisconsin” and press enter on your 

keyboard. Click on the map to dismiss the Extent display. 

 

 

Gather and add the data 

 

This lesson focuses on geospatial data for Green Bay, Wisconsin. You can substitute data for 

your community if it is available. The layers utilized in this section include: 1) municipal 

boundary; 2) neighborhood boundary; 3) land use; and 4) street trees. 

 

1. Click the EXPLORE tab on top. 
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2. Click on the Add Data tab. 

 

 
 

Turn on the Consider your map extent toggle. When turned off, the toggle will appear 

red with the ball on the left side and when turned on it will appear green when ball on 

the right side. 

 

  
 

3. Select the All tab. 

 

  
 

4. In the Search… dialog in the upper right corner, type “Green Bay 2019 Land Use” Scroll 

to find the feature service by that title associated with user 

‘‘dahart@wisc.edu_UW_Mad’. Click Add. 

5. With the same criteria as above search “Fisk Street Trees,” associated with user 

‘dahart@wisc.edu_UW_Mad’. Click Add. 

6. Search for “Green Bay Boundary”, created by user ‘dahart@wisc.edu_UW_Mad’. Click 

Add. 

7. Search for “Fisk Neighborhood Boundary,” created by user 

‘dahart@wisc.edu_UW_Mad’. Click Add. 

8. Once you are done adding data, click Close in the lower right corner. 

 

On your map you can now see that all the layers have been added. To open the Layers panel, 

click on the blue button that look like a stack of layers in the top left corner of the screen. 

 

   
 

The layers you have been added are under Data Layers. Explore the layers a little bit by 

checking them on and off to get an understanding of the geographic layout and connectivity of 
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the area. You can also play around with zooming in and out to see how the Fisk Neighborhood 

fits within the City of Green Bay boundaries. 

 

1. Before moving on, uncheck all the layers except “Green Bay Boundary” and “Fisk 

Neighborhood Boundary” so you are better able to see the location of the study area.  

2. You will now add a bookmark of the Fisk Neighborhood, which can be seen on the West 

side of the river. Zoom into the Fisk neighborhood by clicking on the gear icon just right 

of the Fisk Neighborhood Boundary layer and then select Zoom to. 

3. Click the Extent icon, select > Add Bookmark, and name it “Fisk Neighborhood.” Click on 

the map to close the dialog. 

 

 

Set the study areas 

 

You will be setting two Study Areas. The Fisk Neighborhood, which is your design scenario, and 

the City of Green Bay, which will give you context in the area. 

 

1. Make sure all layers are turned off except the Fisk Neighborhood Boundary.  

2. Click somewhere in the center of the Fisk Neighborhood Boundary. A window will pop 

up. On the bottom click Import.  

 

 
 

3. Name it “Fisk Neighborhood.” Click the Import button. You will see a new layer appear 

under Study Areas in the Layers panel within Contents. Close the table window for the 

“Fisk_Neighborhood_Boundary” attribute.  

4. Turn on the “Green Bay Boundary” layer. 

5. Zoom out to the Green Bay Boundary by clicking the gear icon next to the layer and 

selecting “Zoom to.” Repeat steps 2 and 3 above for this layer by selecting the Green 

Bay Boundary layer, clicking the map somewhere in the middle, clicking Import and 

naming the study area “City of Green Bay.” Close the table window for GB_Boundary by 

clicking the x in the top right corner.  



7 

 

6. At the bottom of the Contents’ Layers panel, you will see a Basemap section.  

 

 
 

By clicking on the four squares next to the Basemap heading, a box will pop out giving 

your options to change this to a variety of different basemaps. The best one for 

assessing impervious surface is called Imagery. 

 

You have now added all the layers you will need to assess the Fisk Neighborhood for green 

infrastructure placement. The next section will lead you through creating individualized features 

and attributes for green infrastructure practices you will use to design your Green Stormwater 

Infrastructure plan.  

 

 

Create the design layers 

 

The design layers are the layers you will use to populate your green infrastructure for stormwater 

management scenario. You will be adding polygon and point feature practices. 

 

Polygon:      Point: 

Green Roof      Tree 

Porous Pavement 

Rain Garden 

 

 

1. First, you will delete the LINE layer because you have no green infrastructure 

practices that are lines. Find this layer under the Contents panel > Layers tab > 

Active Scenario > Line. Click on the gear icon to the right. 
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 At the bottom of the drop-down list, select Delete Design Layer. Choose the Delete 

Layer button. 

2. Next, you will work with the POINT layer. Click on the gear icon to the right of the 

POINT layer. In the middle of the drop-down list, click Design Types. 

3. Notice there are 5 POINT features. Delete Points 2 through 5 by clicking on the trash 

can icon to the right of each one and confirming the deletion. 

4. You will now design the feature’s symbolization. For POINT 1, the Symbol tab should 

be selected. Click Fill, Choose a darker green color. Select the Type tab and enter 

“Tree” for the Label. Select the Default Values tab. Enter the following values - 

Name: Tree, Description: Water capture per storm event and cost, DESIGN FIELD 1: 

50, DESIGN FIELD 2: 269. Click Save. 

5. You will repeat a similar process with the POLYGON layer. Click on the gear icon to 

the right of the POLYGON layer. In the middle of the drop-down list, click Design 

Types. 

6. Notice there are 5 POLYGON features. Delete Points 4 and 5 by clicking on the trash 

can icon to the right of each one and confirming the deletion. 

7. You will now go to POLYGON 1 and edit the Symbol, Type and Default Values.  

The Symbol tab should be selected.  Click Fill and choose a medium green color. 

Select the Type tab and enter “Green Roof” for the Label. Select the Default Values 

tab. Enter the following values - Name: Green Roof, Description: Water capture from 

0.5 inches of rain and cost per square foot, DESIGN FIELD 1: 0.31, DESIGN FIELD 2: 

23. Do not click save yet. 
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8. Repeat the previous step for each of the remaining polygon layers to change their 

information under the Symbol, Type and Default Values tabs using the information 

in the table below.  

 

Original 

Name 

Suggested 

Colors 

Name Description Design Field 1 Design Field 2 

POINT 1 Green Tree Water capture per 

storm event and cost 

50 gallons per 

tree per 

event 

269 $ per tree 

POLYGON 1 Green Green Roof Water capture from 

0.5 inches of rain and 

cost per square foot. 

0.31 gallons 

per sq.ft. per 

0.5 in. event 

23 $ per sq.ft. 

POLYGON 2 Gray Porous 

Pavement 

Water capture from 

0.5 inches of rain and 

cost per square foot. 

0.31 gallons 

per sq.ft. per 

0.5 in. event 

8 $ per sq.ft. 

POLYGON 3 Blue Rain Garden Total water capture 

capacity from 

managed areas and 

cost per square foot. 

5.37 gallons 

per sq.ft. per 

event 

13 $ per sq.ft. 

 

9. Once you finish labeling add adding data to each polygon layer click Save. 

 

Your Green Infrastructure for Urban Stormwater template is now all set up and ready to use. 

Follow the next tutorial in order to design a scenario and create dashboards to visualize and 

measure the cumulative impact of these practices. 

 

 

Create dashboards to measure the impact of green infrastructure practices 

 

Dashboards will be created to visualize the cumulative impact of green infrastructure as you 

place practices around your study area. The dashboards you will be creating will measure water 

capture as it relates to the neighborhood water capture goal, cost and area that has been 

converted to green infrastructure. 

 

1. Click on the small floating square that looks like a timer just to the right of the 

Contents panel. 
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The Dashboard display will open.  

 

 
 

Click the maximize icon that looks like a box in the upper right corner to expand the 

dialog to see all the dashboards. 

 

 



11 

 

First, you will make a series of dashboards that will portray the impact of water 

capture from green infrastructure feature placement. For the Key Performance 

Indicator – Polygon dashboard and click the gear icon. 

 

  
 

o In the Caption box, type Gallons Water Storage Polygon 

o For Type, select Numeric and make sure the Composite box is not checked. 

o For Rounding Style, leave the choice as default. 

o For Scenario Layer, make sure POLYGON is selected and for the Filter drop-down 

click the down arrow and make sure the boxes are selected for all three features. 

o For Equation (per feature): Clear the existing text for [KPI_1] and then use the 

link for the Equation Builder to create the equation 

[DESIGN_FIELD_1]*[squareFeet], then select OK.  

o Select Sum for the next box. This adds all the data from the DESIGN FIELD 1 

attribute which you set earlier in the lesson. It calculates the cumulative water 

capture from all the green infrastructure features you placed. 

o Click Update at the bottom. The dashboard that you just updated will say “No 

data available in this area” because no green infrastructure features have been 

added to the map yet. Don’t worry about this. 
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2. Using the Key Performance Indicator – Point dashboard click the gear icon. 

o In the Caption box type Gallons Water Capture - Point 

o For Type, select Numeric, make sure the Composite box is not checked. 

o For Rounding Style, leave the choice as default. 

o For Scenario Layer, make sure POINT is selected and for Filter, click drop-down 

arrow and make sure the box is selected for Tree. 

o For Equation (per feature): clear the existing text and type [DESIGN_FIELD_1] in 

the equation box (you can also select it through the Equation Builder), then 

select Sum for the next box. This adds all the data from the DESIGN_FIELD_1 

attribute which you set earlier in the lesson. It will tell you the cumulative water 

capture from all the trees you place. 

o Click Update. 
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3. Using the Key Performance Indicator – Line dashboard, click the gear icon. 

o In the Caption box type Fisk Neighborhood Water Capture Goal 

o For Type, select Gauge, make sure the Composite box is checked this time. 

o For Number of Ranges, use the drop-down arrow to select 3. For Target, enter 

1200000 (commas will be added). For the four range boxes, enter: 

 Range: 0 400000 800000 1200000 

o For Equation (composite), click the blue link that says Equation Builder 

 A new box should pop up. Delete whatever is in the top text box. Type or 

click on the links so that the equation reads: [Gallons Water Capture 

Polygon]+[ Gallons Water Capture Point]. 

 Click OK 

o Click Update. Once the editing box has been closed you will see a gauge with a 

black arrow on the left pointing to 0. This is your current water capture. There 

will also be a yellow arrow on the right pointing to 1,200,000. This is your target 

water capture. 

4. Next, you will make a series of dashboards that will portray the cumulative cost of 

green infrastructure feature placement. Using the Area (SQ MI) dashboard, click the 

gear icon. 

o In the Caption box type Polygon Total Cost 

o For Type, select Numeric, make sure the Composite box is not checked. 

o For Rounding Style, leave the choice as default. 

o For Scenario Layer, make sure POLYGON is selected. For Filter, click the drop-

down arrow and make sure the boxes are selected for all three choices. 

o For Equation (per feature), click the blue link that says Equation Builder. In the 

new dialog box, delete whatever is in the top text box. Create the equation 

[DESIGN_FIELD_2]*[squareFeet]. Click OK. Select Sum for the next box. This adds 

all the data from the DESIGN_FIELD_2 attribute which you set earlier in the 

lesson. It will tell you the cumulative cost of all the green infrastructure polygon 

features you place. 

o Click Update. 

5. Using the Area (SQ KM) dashboard click the gear icon. 

o In the Caption box type Point Total Cost 

o For Type, select Numeric and make sure the Composite box is not checked. 

o For Rounding Style, leave the choice as default. 

o For Scenario Layer, select POINT from the drop-down list. For Filter, click the 

drop-down arrow and make sure the box is selected for Tree. 

o For Equation (per feature): type [DESIGN_FIELD_2] in the equation box (you can 

also select it through the Equation Builder) and select Sum for the next box. This 
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adds all the data from the DESIGN_FIELD_2 attribute for points, which you set 

earlier in the lesson. It will tell you the cumulative cost of all the green 

infrastructure point features you place. 

o Click Update. 

6. The last dashboard will calculate the total cost of all the green infrastructure 

practices. Click the hamburger icon in the upper left corner of the Dashboard 

window. Choose Add a Scenario Indicator from the drop-down menu. 

o For Caption, type Cost, Total Estimate. 

o For Type, select: Numeric and check the composite box. 

o For Equation (composite), click the blue link that says Equation Builder 

 

 
 

 A new box should pop up. Delete whatever is in the top text box. Type or 

click on the links so that the equation reads: [Point Total Cost]+[Polygon 

Total Cost] 

 Click OK 

o Click Create. 

7. If you want to rearrange the order of the dashboards, click on the drop-down arrow 

next to the Dashboard title in the black window header. From this drop-down menu 

you can rearrange the order of dashboards as you like by clicking on the dashboard 

name and dragging it to its new location in the order. Just be aware that the Design 

Chart will always remain first. Try ordering the dashboards like this: Design Chart; 

Fisk Neighborhood Water Capture Goal; Cost, Total Estimate; Gallons Water Storage 

Point; Gallons Water Storage Polygon; Point Total Cost; Polygon Total Cost. 

8. In order to make sure your dashboards are including all features placed (not just the 

ones you see) click the hamburger icon in the top left corner of the Dashboard 

window to access the Dashboard Settings. Select the drop-down menu. Choose 

Scenario and Baseline Indicators and select All Features. Under Charts, select All 

Features. Click OK. 
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Your dashboards have now been set. In the next section, when you start designing Green 

Infrastructure for Urban Stormwater scenarios and adding green infrastructure features to your 

map, you will be able to see, in real time, your dashboards updating. Close your dashboard 

window and move onto the next section to create your first green infrastructure scenario. 

 

 

Design green infrastructure scenarios 

 

Using the design component of the GeoPlanner software you will now be able to draw out the 

different types of green infrastructure features that you added earlier in order to manage 

stormwater runoff by capturing and infiltrating it with your practices. 

 

Create a scenario using only trees 

The first scenario you will create will use only the tree point feature in order to see how much 

water can be captured and what the impact will be on the stormwater capture goal. You will 

place tree features around the study neighborhood at your discretion, then you will reference a 

data layer to help guide your tree placement to be more effective. 

 

1. On the top ribbon in the upper left corner click on the header Scenario A 

 

 
 



16 

 

a box will open.  

 

 
 

Click on the gear icon.  

 

A new dialogue box will open, select Edit. Yet another box will open titled Edit Scenario 

Properties.  

 

 
 

o In the Title box type: Tree Scenario 

o In the Summary box type: This scenario will utilize trees as green infrastructure 

features to capture water for urban stormwater management. 

o In the Description box type: On average, trees have the capacity to hold about 

50 gallons of water from a single storm event. This is dependent on the size, type, 

and location of the tree. Using trees for urban stormwater management 

practices is a new area of study and the true impact is yet to be determined. 

However, current research points to the conclusion that they do potentially 

reduce flooding and increase infiltration. They also provide many other 

ecosystem services such as shade, nesting for birds, improve air quality, and slow 

the flow of water.  
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o In the Tags box type: Stormwater trees, urban stormwater management, green 

infrastructure 

o Click Save. 

2. You will now activate your study area. In the contents panel, under Study Areas, select 

Make Active next to the Fisk Neighborhood.  

 

 
 

3. Make sure all the data layers are unchecked except the Fisk Neighborhood Boundary. 

4. Change the basemap to Imagery if it isn’t there already so you can see where trees 

already exist on the aerial photography. Zoom into the park. 

5. Select the Design tab on the top ribbon to access your tree features. Then select the 

pencil icon. 

 
 

6. Now, you can start placing trees as green infrastructure practices.  

a. The Symbol Palette box will pop open on the right side. 

 
b. Under the point category, make sure Tree is selected. Move your curser over to 

the map to start placing points. To add a tree, move the cursor and click where 

you want add a tree feature. Add 10 trees to the park. 

c. When placing trees, start to think about which locations are most feasible. You 

wouldn’t want to place them in the middle of sports fields, you also wouldn’t 

want to make every park space into a forest. Additionally, trees require about 

15-20 feet for their canopy and roots to expand. 

d. Open your dashboard, the timer icon, to start to see the cumulative impact your 

tree features have on your water capture goal. If you configured the design fields 

correctly, the progress towards the “Fisk Neighborhood Water Capture” goal 
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should be 500 gallons (50 gallons per tree) and the “Cost, Total Estimate” should 

be $2,690 ($269 per tree). 

 

 
 

7. Challenge: Use the Fisk Street Trees layer to help guide appropriate tree placement in 

other parts of the neighborhood.  

o Fisk Street Trees will help you identify where there is a lack of planted trees 

along streets.  

8. Go back to the Design tab, click the pencil icon, select tree, and start placing your tree 

features based on the new layer. 

9. Watch the dashboards and see how the Fisk Neighborhood Water Capture Goal and 

Cost, Total Estimate changes. Notice, however, that you will not make significant 

progress towards your water capture goal until you add thousands of trees. In the next 

scenario you create, you will add additional green infrastructure practices that have a 

larger impact on your water capture goal. 
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Create a scenario using polygon features  

This new scenario will focus on using rain gardens, green roofs and porous pavement as green 

infrastructure practices to meet the water capture goal for your study area. You will be using the 

same layers from the tree scenario in order effectively to place the features.  

 

1. To create your new scenario, click the Tree Scenario heading in the upper left corner of 

your screen. Select Create. 

o For the Title type: Infiltration Scenario 

o For the Summary type: This scenario uses infiltration-based features to 

capture water for urban stormwater management. 

o For the Description type: Infiltration-based practices are able to manage rain 

where it falls and allow it to slowly seep into the ground thereby slowing the 

flow and preventing water from immediately runoff into a water source or 

the storm system. Rain gardens, in particular, are designed to be able to 

manage water from a larger area than what initially falls upon the footprint 

of the feature. This provides the opportunity to plant them near sidewalks or 

driveways in order to manage water from those sources. Porous pavement 

allows for direct infiltration of water on the surface, but do not manage 

water from surrounding areas. This practice is especially beneficial in parking 

lots. Green roofs work by preventing water from directly running off the roof 

(an impervious surface) and capturing rain from smaller events. Rain gardens 

and green roofs also provide extra habitat for birds and insects.  

o For the Tags type: Rain garden, green roof, porous pavement, urban 

stormwater management, green infrastructure 

o Click Create. 

2. In this scenario you will place infiltration features around the Green Bay West High 

School property to see what type of impact they will have on the total water capture 

goal. Make sure your basemap is still set to imagery. The high school is in the southeast 

corner of the Fisk Neighborhood. 

3. Open your dashboards again if they aren’t already. You will place two of each of the 

three polygon green infrastructure practices on the West High School property and see 

how these impact the total water capture goal. 

a. To start placing the polygon features go to the Design tab, click the pencil icon, 

select the POLYGON category at the very bottom of the right panel. For this 

scenario, your choices are rain garden, green roof, and porous pavement. Next, 

select whichever feature you would like to place and Draw by using the different 

polygon shape options to create your feature design. The default draw tool is the 

free form polygon. 



20 

 

i. Remember that green roof features should only be placed on rooftops, 

rain gardens should only be placed on the ground (think: lawns, gardens), 

porous pavement is meant to replace pavement (think: parking lots, 

driveways, sidewalks). Avoid placing these features on sports fields and 

completely covering all park space.  

 

 
 

Challenge: Try to place enough polygon features to reach the 1,200,000 gallon capture goal 

for the entire Fisk Neighborhood study area. Toggle on and off the “Green Bay 2019 Land 

Use” layer to guide placement of green infrastructure practices. Yellow parcels are 

residential land use, red parcels are commercial land use, purple parcels are institutional 

land use and green parcels are recreation and open space land use. 
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Comparing scenarios 

When attempting to create a green infrastructure plan it is always important to consider cost in 

addition to water capture. Communities usually are limited on funding so fitting a water capture 

goal as well as practices to this constraint can be tricky. Additionally, planning green 

infrastructure to make the biggest impact requires an understanding of the surrounding 

landscape. General knowledge of soil types, hydrologic flow, current and future climate, 

precipitation trends, land use and land cover for the area is critical for developing an impactful 

plan. Not only that, community input should be a major effort and consideration in such a 

project. 

 

Now that you have created two scenarios, one with tree features and the other with infiltration-

based features, you can start to switch between them and compare the dashboards. This allows 

you to start to understand which green infrastructure practices may have the most impact and for 

what cost. 

 

1. Make sure the dashboards are open so you can see the Fisk Neighborhood Water 

Capture Goal and Cost, Total Estimate. 

2. Switch between your two scenarios that you just created and observe the differences in 

the dashboards. See how with trees it is difficult to meet the water capture goal, but 

they are less expensive. On the other hand, using infiltration practices you can easily 

place enough features to meet the goal, however the cumulative cost is greater. Look 

through the different dashboard to see how they differ and think about the possible 

implications for your community.  

a. Consider the age and maintenance cost of the different green infrastructure 

features. Trees take 30 or so years to reach maturity and therefore their canopy 

will not manage large quantities of water until a number of years after they are 

planted but they last longer (if maintained correctly). 

b. Consider regional climate. Which practices may do better in warmer, wetter 

climates? How about hot and dry ones? Think about cool temperatures? Even 

climates with a lot of precipitation. These climates have a big impact on which 

green infrastructure practices will function well and thrive. 

c. Consider space requirements. Urban areas will have less space and planners will 

have to be more creative to place green infrastructure. 

d. What other considerations may impact green infrastructure placement? 
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Takeaways 

Now that you have gone through the lesson and set up the template, gathered and added the data, 

set the study areas, created the design layers, created dashboards, and designed and compared 

scenarios there are five main takeaways to consider. 

 

It is easy to build your own template 

Using the Basic Template, it is easy to adjust the design layers, change the dashboards, add data, 

design, and evaluate your plan in accordance with your community specific needs. While there 

are several curated templates available, customization is part of the GeoDesign process. 

Designing your own template allows you to create a location-specific schema that will be most 

useful and targeted for your project.  

 

You can leverage data available to your community – in addition to broad-scale layers widely 

available in Esri’s Living Atlas 

Many communities have local data available in open data portals. These can typically be found 

on the city, county or state level. Adding local data provides and deeper level of detail as you 

plan for more site-specific projects. This data can help guide green infrastructure placement as 

well as constrain it to more ideal locations. For example, you would need different strategies that 

would incentivize residents to place green infrastructure on their land than you would for 

placement on government/institutional property or commercial. 

 

You can incrementally design and visualize impacts as you go along in an individual scenario 

Dashboards are a powerful visualization tool that allow you to visualize impacts in real time as 

you place green infrastructure features on the landscape. Seeing the numbers tick up with the 

addition of features make the impact more real. It is a good way to present the information to 

community members by allowing them to understand how green infrastructure can impact water 

capture and potentially flood prevention. 

 

You can compare between different scenarios 

Scenario comparisons provide the potential to decide which course of action may be most 

beneficial for a community. Especially through comparing cost and water capture you can start 

to get an understanding of which combinations of features can make the most impact while 

staying within budget. 

 

You can compare between different geographic scales: site level vs. neighborhood vs. citywide 

Visualizing green infrastructure placement at a site level can be influential towards meeting a 

stormwater capture goal. Through this lesson, by placing trees and infiltration-based features first 

at site level then at the neighborhood level you have started to get a sense of scale comparison. 

From a high level the amount of water captured by these features are small, but at a site level 

they are significant.  
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Create your own template 

 

Suggested data: 

• Boundaries (neighborhoods, municipalities, or other places of interest) 

• Land use 

• Land cover 

• Hydrologic soil group 

• Storm basins 

• Watersheds 

• Elevation 

 

Green infrastructure practices: 

There are many green infrastructure practices that a community may consider adding to the 

design layers. Examples include: 

• Rain garden 

• Bioswale 

• Engineered wetland 

• Green roof 

• Rain barrels 

• Soil amendments 

• Native plantings 

• Porous pavement 

 

Water capture goal: 

Use rainfall data specific to your location. Determine capture goals based on community needs 

and capabilities. 

Examples: 

• Capture the first one-tenth, one-half or one inch of individual rainfall events from all 

impervious surfaces. 

• Capture a certain volume of water based on the annual rainfall event for your location. 

An example would be the increase of annual precipitation expected in a changing climate. 

• Convert a specific area of land from impervious to a surface with greater infiltration 

capacity. 

 


